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Preface

This guide helps you start using the K1297-G20 Monitor with version 3.00
software. Refer to the K1297-G20 Monitor online help system for more
information about using the K1297-G20 Monitor.

NOTE. Some of the screen shots have been modified and might not appear
in exactly that form on your screen.

To work with the K1297-G20 Monitor, you should have the following
qualifications:

� Knowledge of the measurement application field as well as experience
with communications test applications

� Familiarity with signaling protocols

� Knowledge of PC and Windows XP

� Familiarity with the safety requirements for electrical equipment for
measurement, control and laboratory use

� Completion of a K1297-G20 training course

NOTE. The participation in a K1297-G20 Monitor training course is
recommended. Information on training courses is available from your local
sales partner or via the support unit.
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About This Manual
This manual is divided into the following sections:

� Preface provides an overview of this manual.

� Basic Operations describes most of the features of the K1297-G20
Monitor and gives examples of how to use them.

� GPRS Monitoring describes how to configure GPRS measurements.

� Appendix A describes some features of the K1297-G20 user interface,
such as tool bars, menu bars, short cuts and buttons.

NOTE. More detailed information about each of the sections contained in
these chapters can be found in the K1297-G20 Monitor Online Help.
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Conventions
The following text styles and markings have specific meaning in this
manual:

Text style Description

Italics Italics fonts indicate menus and menu functions as well
as commands, parameters and examples.

<Key> Keys or key sequences are in angle brackets.

Bold Bold fonts indicate buttons of the Graphical User
Interface.

RMC Right mouse click

Instead of using the menu entries or toolbar buttons, you
may use the right mouse click (RMC) anywhere in the
program to shortcut certain functions.

LMC Left mouse click

-> Refers to a menu name or entry
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Related Manuals and Online Documentation
This manual is part of a document set of standard-accessory manuals and
online documentation. See the following list for other documents
supporting the K1297-G20 Monitor Protocol Tester:

� The user manual K1297-G20 Monitor Protocol Tester provides all
user-relevant product information. It assists you when setting up and
starting the protocol tester for the first time. This user manual is
available in printed version and as a PDF online manual in the \hlp
directory.

� A context sensitive online help system is the reference documentation
for the graphical user interface of the K1297-G20 Monitor. To open the
Help window, press <F1> from within a K1297-G20 Monitor
application window. 

� The Protocol Assistant is the detailed protocol reference documenta-
tion. To open it, press <F2> from within the monitor main window. The
Protocol Assistant reflects the tester’s software implementation of
protocols.

� The Release Notes are delivered separately and contain the latest
information on the current software version (readme.txt).

� Windows XP online help: To open the Windows XP online help, click
in the taskbar on Start: Help abd Support.
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Service and Support
When you purchase a Tektronix product, Tektronix provides support to
complete your solution. Technical support experts offer application-specif-
ic solutions and worldwide flexible support services, including on-site
support, are designed to ensure that your instruments operate at peak
performance. You will receive a timely response when you need it, where
you need it.

NOTE. The Windows XP installation is an OEM version. Therefore the
Microsoft Support cannot be used. The Protocol Tester is supported by
Tektronix only.
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Contacting Tektronix

Address Tektronix Berlin GmbH & Co. KG
Wernerwerkdamm 5
13629 Berlin
GERMANY

Web site www.tektronix.com

Technical 
support

For hotline service support, call:

+4930-386-22200 
(8:00 a.m. – 00:30 p.m. GMT + 01:00 and 
01:30 p.m. – 6:00 p.m. GMT + 01:00) 

or
1-800-833-9200 (This phone number is toll free in North
America. After office hours, please leave a voice mail
message. Outside North America, contact a Tektronix
sales office or distributor; see the Tektronix web site for a
list of offices.)

Or fax:
+4930-386-22546

Or contact us by e-mail:
mpt.hotline@tek.com
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Basic Operations

To run a measurement, you must configure hardware and software
according to your desired measurement scenario.

Before you configure a measurement scenario, set up the device, install
the measuring modules and switch on the device (therefore see the Getting
Started chapter in the User Manual K1297-G20 Monitor Protocol Tester).
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Installing K1297-G20 Monitor Version 3.00
For detailed instructions on how to install a new software version refer to
the Getting Started chapter in the User Manual K1297-G20 Monitor
Protocol Tester.

When installing version 3.00, differentiate between the following software
types:

K1297-G20 Monitor Protocol Tester System Software V3.00

Existing configuration files created by older versions of the K1297-G20
Monitor software are - dependent on the stack - compatible with version
3.00. You should therefore save your configuration files before installing
the new K1297-G20 Monitor version.

K12xx PC Monitoring Software

You can install K1297-G20 Monitor software on a PC running Windows
NT 4.0 with Service Pack 6a, Windows 2000 or Windows XP Professional.
You can either install the Record Viewer, which is provided on your
K1297-G20 Monitor software CD, or you can obtain the PC Monitoring
Software, which has a wider range of features.

The PC Monitoring Software package allows you to analyze K1103,
K1205, and K1297 recording files off-line on your PC. The software
includes the full functionality of the Offline Scenarios pipeline and the
Record Viewer pipeline including all standard K1297-G20 Monitor
applications, statistics, filtering, and triggering functions (refer to section
Online and Offline Pipelines).

K12xx Record Viewer

The Record Viewer allows you to view and print recording files, to filter
or zoom the recorded data stream, and to edit or create protocol stacks.

The functionality of the protocol stack editor and of the online help is not
restricted. If used on your PC, the setup routine will require your
K1297-G20 Monitor serial number and the file keyfile.txt 1 must be copied
from the K1297-G20 Monitor keyfile diskette to the PC.

1 The file is located in C:\WINNT on your K1297-G20 Monitor
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Starting K1297-G20 Monitor Version 3.00
After switching on the K1297 the software starts automatically. If this
feature was not selected during installation, you can start the K1297-G20
Monitor software manually by double-clicking on the K1297-Mon icon.

Status Window

The first window that opens is the K1297-G20 Monitor Status Window,
which displays the status of the hardware installation and the boot process.

Figure 1: K1297-G20 Monitor Status Window
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Data Flow Window

The main window is the K1297-G20 Monitor – Data Flow window which
contains a graphical display of configured measuring tasks, called online
and offline scenarios. Each scenario may contain several pipelines for the
specific measuring tasks.

The left part of the window – List of Scenarios pane – contains a list of all
the scenarios, each corresponding to a pipeline in the right part of the
window, the Measurement Scenarios pane. The scenarios define such
things as interface, port, timeslot, and bit-rate for the connected link.
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Figure 2: Data Flow window with pipelines
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Online and Offline Pipelines
Different online and offline pipelines are available. Choose one, and drag
it into the right window to create a new scenario, or connect it to an
existing pipeline.

Drag & Drop

Figure 3: Pipeline buttons

Online measurements monitor live data as it is received; the K1297 is
connected to the links being monitored. Offline measurements use data
stored in recording files.
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Online Pipeline: “On Record”. Online Recording means writing live data to a
recording file. You can define recording files (the procedure is identical
for online and offline pipelines) by clicking the  or  button.

Figure 4: Online recording file pipeline switched ON

The following Recording Write Configuration window is displayed.

Figure 5: Recording Write Configuration window

Overwrite mode is the default if there is an existing file that can be
overwritten. 
Append mode is used to add data to the end of an existing file.
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CAUTION. A necessary prerequisite when using Append mode is, that the
configuration of the pre-recorded data is the same as the one of the data to
append. All old configurations (such as link-settings) will be overwritten.

You can choose the size of the recording file and the total number of files
used during a single session. For multiple files you can select the rule for
creating a new file. New files will be created after:

� a certain size has been reached

� expiration of a certain time period

� closing of the switch

Next, choose the maximum number of files to be created and the
format/mask for numbering of the filenames.

NOTE. Recording files are limited to 2 GB space.
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Recording files can now be concatenated to create a single file out of two
or more. You can thus have all relevant data from several pipelines in one
recording file: use the Recordfile Merger tool, which is in c:\K1297\tools
directory.

Figure 6: Recordfile Merger tool
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Online Pipeline: “On Monit”. Online monitoring means analyzing data online
in the Monitor window. The pipelines are activated (and the measurement
is started) by clicking the ON/OFF switch in the Measurement Window.
This works only if they are set up correctly. (refer to section Manual
Configuration)

Figure 7: Online monitor pipeline switched ON

Online Pipeline “On Stat”. The Online Statistics measurement scenario helps
you perform statistical analyses using data received online. Use the input
filter to reduce the amount of data being analyzed.

Figure 8: Online Statistics measurement scenario

For more in-depth analysis, the auxiliary program RealChart (see page 73)
provides you with functions for graphically analyzing and evaluating data.

When using the Online Statistics scenario, you can simultaneously write
data to a recording file (Online Recording) and analyze it using the Online
Monitoring scenario by configuring appropriate pipeline branches.
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Offline Pipeline “Off Record”. The Off Record pipeline allows you to
re-record files after processing them offline with applications or filters. Set
up the recording file the same way as described further above for the
online pipeline.

Figure 9: Offline recording pipeline
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Offline Pipeline “Off Monit”. The playback pipeline Off Monit can playback
pre-recorded files in real-time (as if online) or with a defined speed. With
this feature you can view a recorded file offline with exactly the same
conditions as if it were online. Applications (such as calltrace or
sequencing) and filters may also be used.

Figure 10: Active playback monitor pipeline

To play back a file, select the desired file in one of the offline pipelines by
clicking the Open button. The File Open dialog box should pop up. The
file type can be either from K1205, K1297-G20, or Net-X (.rf5), K1103
(.rec) or K1297 (.dat).

To start or continue the playback, click the triangle (play) button. To stop
the playback, click the square. To pause, click the double lines. You can
change the setup (playback speed) by clicking the  button.

The data is now shown in the Monitor window. To switch to the Monitor
window, click the monitor symbol in the appropriate pipeline.

The Record Viewer allows you to scroll through a pre-recorded and
decoded file. You can define filters for the screen output, but applications
are not available.

Open / Close

Figure 11: Record viewer pipeline
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Offline Pipeline “Off Stat”. The Offline Statistics measurement scenario
allows you to evaluate recorded data using the Statistics application.

Figure 12: Offline Statistics measurement scenario

For more in-depth analysis, the auxiliary program RealChart (see page 73)
provides you with functions for graphically analyzing and evaluating data.

When using the Offline Statistics scenario, you can simultaneously write
data to a new recording file (Offline Recording) and analyze it using the
Offline Monitoring by configuring appropriate pipeline branches.
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Scenarios
The Measurement Scenarios tab of the Data Flow window displays the
current configured measurement scenarios and sources. This tab keeps you
informed about the currently active parameter settings and system state at
all times. The gray boxes in the pipelines represent measurement modules,
and the connecting lines indicate the data flow between modules.

You can also perform all operations in the Data Flow window via the
Scenarios RMC menu (refer to section Manual Configuration, Figure
Change the scenarios):

� Configuring, renaming and removing scenarios

� Assigning, editing and removing pipelines or pipeline branches

� Adding, editing and removing logical links

Functions that are not available in the current situation are deactivated.
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Capture RAM

The Capture RAM allows you to define the memory area reserved for
buffering signaling data on the interface modules, either limiting the
amount of data (Linear Mode) or writing received data continuously into
the capture RAM (Ring Mode).

Figure 13: Capture RAM symbol and configuration

You can specify criteria for writing data to the capture RAM in the input
filter. You can set the size of the capture RAM anywhere between 16 KB
and 16384 KB (16 MB).

For example, if during a measurement an unexpected error suddenly
occurs, but the recording pipeline is not activated, saving the Capture
RAM will store this data for later processing in a Recording file: RMC on
the capture RAM symbol → Save Capture RAM.
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Configuration

Autoconfiguration

Using Autoconfiguration. The easiest way to configure the K1297-G20
Monitor is by pressing Autoconfiguration  after the K1297-G20 Monitor
software has started. Connected traffic to whether signalling in SS#7,
LAPD / LAPV, Abis or TRAU running on E1/T1 is detected automatically.

After autoconfiguration, only the protocol stacks have to be set in order to
define how to decode the input data (refer to section Manual Configura-
tion).

If Autoconfiguration  is not selected, choose a saved configuration or the
default configuration. In this case you will have to configure the connected
links manually (refer to section Manual Configuration).

After that has been done you can activate the pipeline (LMC on the switch
symbol of the pipeline), and start decoding (LMC on the monitor symbol
of the pipeline).

Switch-Symbol
Monitor-Symbol

Figure 14: Monitor pipeline switched ON
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Autoconfiguration Wizard. This feature allows you to limit the scan of the
autoconfiguration to specific signaling types, ports and channels. In
addition, the assignment of logical links to online scenarios is controlled.
You can create and load different strategies depending on the measure-
ment.

The K1297-G20 Monitor is delivered with a standard strategy, stan-
dard.stg. It is used if there is no other strategy in the system. You can use
this file to create your own strategies.

For example, if you use the K1297-G20 Monitor only for GSM A interface
monitoring, you can define the appropriate protocol stack as a standard.

The Autoconfiguration Wizard is located in → Tools → Autoconfiguration
Wizard.

Figure 15: Autoconfiguration Wizard (one of the dialog windows)
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Manual Configuration

To configure the K1297-G20 Monitor manually, follow these general
steps:

1. Switch to the Cards Overview pane in the Data Flow window (see
Figure 16). Use the Cards Overview tab on the lower left part of the
screen.

NOTE. <ALT+A> and <ALT+M> are the easiest way to switch between
Cards Overview and Measurement Scenarios view.

The installed interface cards will be displayed graphically. The
following figure shows the display for one DS1/E1 monitoring board,
one Ethernet board, one BAI board, and one V./X. board.

Figure 16: Card Overview window
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2. Click on  to enter the dialog box for the settings of the

interfaces.

3. Enter the physical settings for your connected links. The dialog box
varies depending on the installed cards.

For example, choose E1 or DS1 frame type, impedance, and line code
for the DS1/ES1 card.

Names for the ports can be assigned here, too. The default values
match the imprint on the interface.

NOTE. The Additional Processor Board (AP-4) is a single slot card that
increases the K1297-G20 Monitor’s processing power by a factor of 5 to
10 depending on the application. When using 3 or more measurement
cards it is recommended to include the AP-4 card; it is necessary when
using 5 or 6 boards in the K1297 benchtop device.

The Ethernet board (ETH) is equipped with four 10BaseT or 100BaseTX
ports and supports full and half duplex mode.
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The following screenshots show port configuration examples:

Figure 17: Port configuration, properties for a DS1/E1 monitoring board

Figure 18: Port configuration, properties for an Ethernet board
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4. Confirm the settings and switch back to Measurement Scenarios pane
(click the other small tab on the lower left part of the main screen).

Now that the ports are set up, the K1297-G20 Monitor has stored the
characteristics of the signaling traffic. The next step is the definition of
the logical links, which indicate where to expect the signaling and how
to decode it (defined by the protocol stacks).

5. LMC on the Online Scenario button (refer to Figure 19) for the Logical
Link Setup dialog box.

Figure 19: Logical Link Setup

The Logical Link Setup dialog box looks different depending on the
chosen interface. A few of the main settings are defined in the
following list:

� Monitor in Tx and Rx direction (with identical or different
settings).

� Edit the name of this link for better overview later in the Monitor
window. The chosen name will be displayed there.

� Choose correct protocol stack for decoding the signaling traffic.

� Choose the correct timeslot (default is TS 16) and subslots if
available.

After defining one link, you can create more settings until all your
connections are defined.

If you want to create a new logical link with settings identical to an
existing one, select the appropriate logical link in the Logical Links of
Scenario list. Then click New. Another way is to press <ALT+N> or
<Insert>.
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Figure 20: Logical Link configuration, example for a DS1/E1 interface

Figure 21: Logical Link configuration, example for an Ethernet board
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Figure 22: Change the scenarios

Logical links may also be defined or added by RMC in the Scenario
list. Press RMC in the left part of this window to access the context-
menus to add/remove/rename/change the online and offline scenarios.
Refer to section Scenarios and Figure Logical Link Configuration
(DS1/E1 Board).

With these settings it is possible to start the measurement. Activate the
pipeline (refer to section Configuration):

6. Switch to the Monitor window by clicking on 

By default, the Monitor icons are identified serially numbered. This
identifier is also displayed in the title bar of the Monitor window
(monitor name) . To change the monitor name, press RMC on the
Monitor icon and click Edit Monitor Name.
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Saving and Loading Configurations

You can save configurations in setup files. You can save any number of
configurations and load them individually as required.

How to Save the Current Configuration 

Proceed as follows:

1. Choose → File → Save System Configuration 
or File → Save System Configuration As 
or press <CTRL + S> .

2. The Save dialog box opens and the c:\K1297\config  directory is
displayed. Enter the desired name for the configuration file. The file
extension (*.s) is added automatically.

3. Confirm your entries with Save.

NOTE. The system only saves settings for the currently installed interface
cards. Information about previously installed interface cards is lost, if you
load a configuration with hardware settings that do not correspond to the
current installation and save this configuration again.

The last used configuration is loaded automatically 30 seconds after the
measurement software is started. During these 30 seconds, a dialog box is
shown with which you can start the autoconfiguration or another setup file.

NOTE. If the system cannot detect a saved configuration, the default
configuration is activated.

It is also possible to load a saved configuration (setup file) at a later point
of time, such as after completing a measurement in order to begin a new
one with different parameters.
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How to Load a Saved Configuration 

1. Select one of the setup files from the pick list in the File menu 
or choose → File → Open System Configuration 
or press <CTRL+O>. 

The Open dialog box appears, and the directory c:\K1297\config  is
displayed.

2. Select the desired configuration file.

3. Confirm your selection by selecting Open.

Either accept the configuration as is or change the settings before starting
a measurement.

NOTE. If an error occurs while the system is loading a setup file, the most
recently loaded configuration is reactivated.
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Auto Restart

The K1297-G20 Monitor will restart (such as after a power failure) with
the last saved configuration (refer to section Saving and Loading
Configurations) or the default configuration if you did not save a
configuration.

When running un-monitored long-term measurements, measurement data
may be saved in a recording file. If the measurements are interrupted by a
power failure, for example, you may automatically continue with the
measurement after restarting the K1297.

1. Set up a long term measurement.

2. Configure the measurement with an online recording pipeline.

3. Save the configuration.

4. Start the measurement.

NOTE. To autostart your K1297-G20 Monitor after a power failure, select
Start the K1297-G20 Monitor application at every system start-up in the
K1297-G20 Monitor setup program. This copies the K1297-G20 Monitor
program into the Autostart folder of WinNT. This may also be done
manually if you want to change it after installation.
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Monitor Window

The Monitor window displays measurement data that is currently received
or played back from a file.

The title bar of the Monitor window shows the type of scenario (e.g.
Online/Offline), the monitor name, and the data source. To change the
monitor name, press RMC on the Monitor icon in the pipeline and click
Edit Monitor Name.

The display of the data is split in three panes with different display levels:
Short View, Frame View, and Packet View. You can control these windows
by dragging the frames and hide or show them with the buttons

 (refer to chapter Appendix).

Short View

Frame View

Packet View

Figure 23: Monitor window
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LIVE Mode and FREEZE Mode

Incoming frames are displayed immediately (live), 
and the screen scrolls automatically.

Scrolling is performed manually with the cursors.
Freeze mode suppresses the continuous display of new 
data allowing a more detailed analysis of frames.

Switch between Live Mode and Freeze Mode with the buttons in the
toolbar. Freeze is activated automatically when you open the Monitor
window during a live measurement.

Frame View, Packet View and Short View

Frame View. The frame selected in the Short View is shown in the Frame
View window pane. Here, it is displayed completely decoded down to the
bit level. The first column shows the selected octet, the second column
shows the name/meaning of the octet, and the third column shows the
comment or value of the parameter. The protocol stacks loaded with the
scenario determine which protocol parameters are shown.

Display level and color of the protocols can be changed in the Frame View
for a better overview (RMC, Monitor Setup, Display Level or Colors of
Protocols, or use the toolbar button ).

NOTE. When scrolling through the Frame View with the cursor keys, the
scrolling will stop at the beginning or end of the marked frame. To switch
to the previous / next frame press <CTRL+↑> or <CTRL +↓>.
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How to Set the Display Level. To set the display level within the Frame View
window pane, proceed as follows:

1. Select the desired protocol.

2. Select the desired level. The Level list box indicates the display level
currently assigned to this protocol. The description file (.upd-file)
assigned to the protocol determines which display levels are selected
and which parameters are displayed:

� Complete: display all protocol parameters 
(shortkey CTRL+9>)

� Medium 1,2...: display some protocol parameters 
(shortkeys <CTRL+1, CTRL+2>)

� Layer Only: reduced representation 
(shortkey <CTRL+0>)

� Hidden: no protocol parameters displayed

To define the display level for further protocols, repeat these steps.

3. Confirm your settings with OK.

NOTE. The display level setting for a specific protocol is applied to all
open Monitor windows.
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Packet View. The Packet View window pane displays the frame selected in
Short View in HEX or ASCII, HEX plus ASCII, Binary, or EBCDIC. If
you select an individual protocol parameter in the Frame View, the
corresponding values are highlighted in the Packet View matrix (refer to
the online help for further details).

Short View. This Short View window pane lists the data packets (frames)
recorded by the K1297-G20 Monitor, displaying signaling data in single
rows and short form. The preset columns display the time stamps, logical
links, protocol names, and messages of levels 2 to 4.

You can assign specific foreground and background colors to each logical
link for a better overview. Assign the color settings when creating the
logical link settings (refer to section Manual Configuration) or when
opening a recording file. You can also change the settings by clicking the
buttons Setup or Change in the pipeline (refer to Figure Recording File
Write Configuration window).

Figure 24: Short View with colored logical links (gray scaled)

All data events and error messages of the logical link are displayed with
these color settings in the Monitor window.
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Column Configuration

The Short View lists the recorded data frames (data packets) in short form.
The preset columns display the time stamps, logical links, protocol names,
and messages of levels 2 to 4.

Figure 25: Column Configuration for Short View
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With RMC Column Setup or  in the Monitor window, you can change
the setup of the number and type of the columns in the Short View.

To display/remove the Release Cause in an ISUP connection, proceed as
follows:

1. RMC Column Setup.

2. Scroll in Available Columns down to REL cause and select the entry
(more entries may be selected if desired).

3. Click the Add/Remove  button. The column will be moved to Selected
columns.

You can move a selected single entry up and down by pressing the Up
and Down buttons.

4. Confirm with OK. The Short View is updated and the new parameters
are displayed.

You can also save the column configuration, allowing increased flexibility
in analyzing data in the Short View. Use the Save and Load buttons for
this. The files will be saved with the extension .mcc.
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Zoom Function

You can use the zoom function to display all messages for a single
connection, for example ISUP: CIC; SCCP: reference number;
TCAP: Transaction ID or IP MGCP: CMD/RSP Call Id; 
ISDN: SAPI/TEI/Callreference.
The zoom function does not affect your display filter setting.

To activate zoom, use toolbar button , RMC Zoom, or press z; 

to undo zoom, use toolbar button , RMC Zoom again, or press
<SHIFT+z>.

The zoom function is currently available for GPRS, IP, ISUP, TUP, ISDN,
SCCP (BSSMAP/DTAP), MAP, and INAP protocols.

Figure 26: Zoom results
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Depending on the protocol a dialog box opens for setting the zoom
parameters:

Figure 27: ZOOM Filter Configuration dialog box
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SPC/CIC Grouping

Using the K1297-G20 Monitor for international traffic makes it necessary
to adapt the SPC/CIC to the appropriate lengths and formats. To change
the display, use RMC Monitor Setup, SPC/CIC Grouping.

Figure 28: SPC/CIC Grouping definition

You can set the SPC Length to 14, 16, or 24. These options specify the
number of bits used for the signaling point code of filter inputs.

The selected SPC length determines the selection options in the list box
SPC Grouping. Use these settings for the SS#7, GSM and IN protocol
stacks.
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If the SPC length does not match the data, the K1297-G20 Monitor cannot
decode the messages properly. The SPC Grouping setting affects only the
display, and the number of bits must correspond to the actual SPC length.

You can choose the grouping from the predefined settings, or you can
define custom needs (Edit button).

NOTE. The setting in the Monitor window is temporary. To attach an
SPC/CIC setting to a protocol stack, define SPC/CIC in the Protocol Stack
Editor (refer to section Protocol stacks) with RMC Monitor Setup, Monitor
Setup, SPC/CIC Grouping, and then check the Save to Stack File box.



Basic Operations

36 K1297-G20 Monitor V 3.00 Short Introduction

Timestamps

The K1297-G20 Monitor assigns a time stamp to each event received,
indicating the time of reception. The stamp has the format
hh:mm:ss:ms:µs. In Freeze mode, it is possible to evaluate this difference
between single events.

To analyze the time difference between two recorded events, switch to
Freeze mode.

Select the event in the Short View that is to serve as the reference point of
the difference calculation and press F9, or select Monitor → Reference for
Timestamp → Set. 
Select the appropriate timestamp format (see figure below).

Figure 29: Timestamp format

The event set as the timestamp reference remains highlighted and is now
indicated by the following anchor symbol.
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Now select any other frame in the Short View to see the time difference.
The frame number of the reference point, currently selected frame number,
and timestamp difference (+/-) are displayed in the status line at the
bottom of the Monitor window.

Figure 30: Timestamp data

The Time difference field indicates the difference in hh:mm:ss:ms:µs. A
negative difference appears, if the starting point event occurs before the
reference event.
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Save or Print Marked Frames

The contents of the monitor or capture RAM may be saved or printed as
decoded ASCII text or written undecoded in a K1297-G20 Monitor
recording file:

1. With RMC in the Monitor window you can choose between Save
Marked Frames As... and Print Marked Frames.

2. Desired frames can be marked/selected by pressing <SHIFT> and
dragging the mouse.

NOTE. The Find option jumps only to matching frames, and the Filter
option hides all non-matching messages.
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Filter
Start the Filter Setup dialog box in the monitor pipeline by LMC on the
symbol. You can either use the Filter before the Capture RAM or before
the monitor application.

Depending on the stack, different filters in the data flow diagram are
displayed at the bottom of the window (yellow and green) when changing
the settings.

Figure 31: Filter Setup, Protocols tab
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Example

Example of filtering an ISUP connection for all Release messages with the
Release Cause Normal Call Clearing (use the file wbisup.rf5 that comes
with the software):

1. Click on the Filter symbol in the pipeline.

2. Click Reset to put the filter in a defined mode, and verify that the
bypass option in the lower part of the dialog box is unchecked. 
This box will automatically become unchecked once a filter is properly
configured and activated.

3. Select the Protocols tab. Uncheck the Bypass Protocol Filter box in the
top left corner of the tab.

4. Press No Protocols below the Protocols pane. ( No Protocols is a
context-sensitive button that might appear as All Protocols. If not yet
active, press the All Protocols button, first).

5. In the Protocols pane select ISUP (if the marker turns green, press No
Messages below the Messages of ... pane).

6. Scroll down, and select REL in the Messages of ... pane (if the marker
turns green, press Ignore Message below the Messages of ISUP pane).

7. Enter cause in the Search for field and press Search three times.

Parameter Cause Value will be marked in the Parameters of ISUP/REL
pane.

8. Press Edit. The Edit Parameter Value dialog box appears.
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Figure 32: Edit filter parameter values

9. Select Normal Call Clearing at Predefined Values 
or choose Dec at Value(s) and enter 16 in the field directly.

10. Press OK and check the box of the parameter Cause Value and confirm
with OK. The monitor will be updated and only the selected REL
message will be displayed. Note that errored events will also be shown
unless they are filtered out.
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K1297-G20 Monitor version 3.00 has widened your possibilities to enter
and edit filter parameter values.

If you want to enter a value range, select the Dec, range format. A range is
represented as a set of two values in square brackets separated by a dash.

Figure 33: Editing value ranges

Enter parameters of MAC, IP4 , and IP6 in grouping format as shown in
figure 34 below.

Figure 34: Editing values in Hex, grouped format
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K1297-G20 Monitor version 3.00 checks for correctness of the entry in the
Value(s) field. A yellow mark will appear, if size or range of the value are
incorrect; in case of a syntax error the mark will turn red.

Figure 35: Warning information: Entered value is above maximum

NOTE. Filter configurations can be saved and loaded in separate files with
the extension .flt. You can also copy one filter configuration to another via
the system clipboard with the commands Copy and Paste. RMC on the
Filter symbol in the pipeline.

You can reset a filter configuration with one click or disable the filter
configuration temporarily by activating the Bypass checkbox in the filter
dialog box.

The Bypass function is displayed graphically in the pipeline. If a filter is
configured, its pipeline box shows a bold font. If it is bypassed, the
graphic shows a wire that goes around the filter.

To quickly activate /deactivate the Bypass function, press <CTRL + b>.

NOTE. Filters are set to Bypass by default. This allows the K1297-G20
Monitor the fastest operation. To activate a filter, make sure the Bypass
box is unchecked.
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Expert Mode

Figure 36: Filter Setup tab Expert Mode

The Filter Setup tab Expert Mode gives you full control on logical
relations of filter settings.

By default, the Current configuration box is set to read-only (see example
above). The script in this box shows the configuration as set in the other
tabs of Filter Setup.
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To edit the filter configuration in expert mode, click on Enable user
defined configuration. Now, you can insert, edit, or delete expressions in
the Current configuration box.

NOTE. Once Expert Mode is enabled via clicking the Enable user defined
configuration  box, all other filter pages are deactivated. To reactivate
those pages press Reset. This operation discards all unsaved configuration
settings.
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Trigger
You can use triggers to control measurement processes. A trigger connects
an event with a predefined action. As soon as the event occurs (the trigger
condition is fulfilled), the action is carried out. An event could be the
receipt of a specific message. A trigger action could be the display of a
user-specified message.

The settings of a trigger always refer to the data source (source or
recording file) of the respective pipeline. Depending on the trigger
definition, the trigger conditions could apply to the entire pipeline or to
individual branches.

The configuration of triggers is similar to the configuration of the input
filter, but a trigger lets all data frames pass through. If a specific data
frame is received (an ISUP IAM) or a specific system state is reached (a
certain point in time), the predefined action is carried out (termination of
the measurement).

To configure triggers, click the trigger pipeline element.

Trigger element

Figure 37: Trigger pipeline element

Trigger settings are saved in the configuration file (refer to section Saving
and Loading Configurations).

The following example explains how a trigger works. The trigger in this
example (ISUP) accomplishes the following tasks:

� Triggers an IAM for a specific call number.

� After this specific IAM has been received, a recording file starts.

� The recording stops after one hour.
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These tasks are graphically represented in the Trigger Configuration
dialog box as follows:

Figure 38: Trigger Configuration

The following is required for the configuration of the trigger:

� An Online Recording pipeline must be configured.

� In the corresponding data source, a logical link must be configured
with a channel where signaling takes place.

� A recording file must be configured into which the data are written.
Select Create and Close multiple files automatically as recording mode
and a file size that will not limit the recording.

In order for the trigger to accomplish the tasks, two trigger conditions and
three trigger actions must be defined. To create a relation, simply click and
drag the condition to the desired action.
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To change the order of the actions, LMC on each box in the action column
to clear the order number; next, LMC on each box in the desired order of
execution.

Figure 39: Trigger configuration
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Trigger Condition 1

Protocol Filter: 
The trigger must be configured to recognize the IAM. In order to detect
the IAM, the appropriate protocol filter must be set as a trigger
condition.

Two actions are linked to this condition.

Trigger Action 1: 
Close the pipeline branch in which the recording file is configured.

Trigger Action 2: 
Enable trigger condition 2: Time Trigger.

Trigger Condition 2

Time Trigger: 
The data recording is to be terminated after one hour. To enable this
function, a time trigger must be defined with a time period of one hour.
As soon as this period has elapsed, the third and final action is carried
out.

Trigger Action 3: 
Open the pipeline branch in which the recording file is configured.

NOTE. After conditions / actions configuration, always enable the trigger
before closing the trigger window.
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Applications
The K1297-G20 Monitor software package includes applications for
performing a wide variety of problem-based evaluations of signaling data. 
These applications are separate measurement programs and help, for
example, analyzing protocol-specific information.

Overview

The available applications are:

� Abis Monitor
Monitor and graph Abis-Interface parameters such as RXLEV,
RXQUAL, MS/BTS Power, Coverage, Interference, and Island.

� CallMon (Traffic and Call Analysis)
Creates an extensive statistical analysis of calls on all TUP (incl.
BTNUP) and ISUP protocols. Analyzes up to 10 different telephone
numbers or areas of telephone numbers resulting in a csv-file which
can be viewed graphically - e.g. via MS Excel.

� CallTrace / Sequencer
Traces and recognizes calls on the basis of a partially specified or
complete call number.

� Calltrace (Multi-Interface)
Traces one or more calls on several interfaces of a network, searches
for parameters from different network interfaces simultaneously.

� Decipher
Deciphers signalling data on the GPRS-Gb interface.

� GPRS MM/SM Statistics
Displays details of events in GPRS MM/SM networks.

� GPRS Gb Analyzer
Displays details of events in GPRS networks.

� IP Traffic Analyzer
This application shows active communication flows characterized by
IP addresses or specific protocol features over an IP network at high
level. The user can configure the filter object in the K1297-G20
Monitor main application to monitor only the IP traffic of interest.
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� Nortel Frame Number
This application calculates the frame number contained in the data
flow of GPRS Nortel-type protocols.

� PCR (Preventive Cyclic Retransmission)
Enables you to filter out repeated MSUs from an offline pipeline by
means of the PCR procedure.

� Service Profile Statistics
Provides an overview of the IP based TCP and UDP protocols’ service
profiles

� Statistics
Classifies and counts the received signalling data on the basis of
different, changeable criteria. Graphical and alphanumerical evalua-
tion.

The following predefined statistical applications can run without extensive
configuration:

� Busy Hour Call Attempts
Counts the call attempts within a specified time period.

� Count All
Classifies and counts the received messages sorted according to
protocols.

� Erlang Measurement
Measurement of the signaling load on the logical links.

� Traffic Channel Analysis
Analyzes a signaling channel and evaluates the traffic channel
assignment.

These applications display their results in tables or graphically using
RealChart. The results can be saved and exported to various database or
spreadsheet applications.

All applications included with the K1297-G20 Monitor are located in the
c:\K1297\app directory.
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Starting an Application

Start any application by pressing the Application  pipeline element,
selecting the desired function, and pressing OK.

Figure 40: Load / Unload Application Programs

All applications can be initialized while the pipeline is inactive.

Run Two Applications in One Pipeline. It is possible to run two applications in
one pipeline at the same time. Uncheck the Single Mode box. This
activates the right right part of the window shown above. Select the
appropriate function and click on Load / Unload. Loaded functions are
now shown in the list box on the right. To start the applications, press OK.

NOTE. For detailed information on how to run applications, refer to the
appropriate chapters in the Online Help.
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Abis Monitor (AbisMon)

This application gives a statistical evaluation of the Measurement Report
messages on the Abis-Interface. It monitors the parameters of the
Abis-Interface, such as RXLEV, RXQUAL, MS/BTS Power, and creates
graphical results such as Coverage, Interference, Island.

Figure 41: Abis Monitor results
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Busy Hour Call Attempt Statistics

The Busy Hour Call Attempt (BHCA) application counts all the call
attempts (IAM Messages) and calculates the number of call attempts
within hours or days to get an overview of the call traffic on the connected
lines.

The application analyzes all ISUP protocols.

CallMon (Traffic and Call Analysis)

This application creates an extensive statistical analysis of calls for ISUP,
TUP, ISDN, and Abis protocols. It analyzes up to 10 different telephone
numbers or areas of telephone numbers (e.g. all calls to Germany). Results
are stored in a .csv-file  which can be viewed and processed using MS
EXCEL. The following parameters are created: Successful / non
successful calls, average hold time, average conversation time, average
PDD, ASR[%], Calls Res. in Alert[%], Calls Res. in Disconnect[%], and a
number of the different Release Causes.

Figure 42: CallMon results viewed in MS Excel
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Calltrace and Calltrace Sequencer

This application is available for 
GPRS Gb, GPRS Gn / Gp, GPRS Gr / Gc, IP MGCP (Sequencer), ISUP,
Abis and A-Interface (GSM900, GSM1800, PCS1900 and CDMA), INAP,
ISDN, and TUP, depending on the software package(s) purchased.

Select this application (LMC on Application  in the Pipeline), click on the
appropriate protocol, and choose the desired number, parameter, or values
(such as CalledPartyNumber, TMSI, Release Cause, etc.) depending on the
protocol used.

Figure 43: SWISSCOM ISUP Calltrace
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You can set the Filter Mode to suppress frames if you want to see only
those messages that belong to the traced calls. All other frames will be
suppressed. The more precisely the trace numbers are specified, the more
precise the filter can be. The text strings generated by the Calltrace
application are completely displayed in the Short View.

Figure 44: SWISSCOM ISUP Calltrace Cause Value

Four comma-separated numbers can be traced simultaneously. Each of the
numbers can contain the wildcards *, ? and + anywhere in the number.
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Start the measurement by LMC Start, and the result should be similar to
the following illustration:

Figure 45: Example of a calltrace-result (detail)

Sequencer Application. The Sequencer application of the K1297-G20
Monitor simultaneously sorts all call related frames for up to 1000 ISUP
connections. With the trace mode activated, one will get additional trace
information about each call. Outputs are similar to the following
illustration:

The sequencer evaluates calls as follows: the beginning of the message is
the IAM and the end will be the RLC - or a timeout in case there is no
RLC detected.



Basic Operations

58 K1297-G20 Monitor V 3.00 Short Introduction

Call Detail Records.  The CDRs application creates detailed call information,
like the called / calling party number, call duration, hold time, wait time,
response time, etc. Results are written into a CSV file (Comma Separated
Value).

1. To activate the CDRs application, click on the Generate Call Detail
Records (CDRs) box under Application work mode.

2. Select the CDR tab. Determine the Filemode: Choose Overwrite if you
want to create a new file or overwrite an existing file. Choose Append
if you want to add further data to an existing CSV file.

3. Click . The directory C:\K1297\log opens. Create a new CSV file,
or select an existing one.

4. If required, make additional settings on other tabs and start the
Calltrace / Sequencer.

Figure 46: CDR tab
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Calltrace (Multi-Interface) – MICT

Using the Single and Multi-Interface CallTrace (MICT) you can monitor
up to 4 network interfaces. You can search for common parameters such as
phone numbers and measure the time needed by specific network elements
(Delay Measurement). The application provides scenarios for analyzing
the following network interfaces and protocols:

� UMTS UTRAN: Iub, Iu-CS, and Iu-PS interface

� GPRS: Gb, Gn, and Gr interface

� GSM: Abis and A interface

� CDMA2000: A1, A10, A11 interface

� CDMA: IS-41 interface

� SS7: MAP, ISUP, and CAP (INAP)

NOTE. At the moment, the Single and Multi-Interface CallTrace (MICT)
supports maximal three different protocol stacks for each interface.

You can run the Single and Multi-Interface CallTrace simultaneously with
applications that have been loaded in other pipeline branches. You can also
run several Multi-Interface Calltrace applications at the same time.

NOTE. A number of functions of the Single and Multi-Interface CallTrace
(MICT) are also available in the CallTrace / Sequencer application with
which individual network interfaces can be analyzed. For performance
reasons, the MICT does not support all of the search criteria that you can
select in this application (e.g. release causes). Instead it supports search
criteria that can be evaluated during the call setup phase. If you need
more detailed search criteria for your measurements, you should therefore
use the CallTrace / Sequencer.
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Count All

This application counts all the received messages and sorts them according
to protocol and message type. The following diagram shows the Overview
results.

Figure 47: Count All Overview results

Messages can also be sorted by specific protocol within a protocol stack.

Figure 48: Count All results for a specific protocol (ISUP)
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Decipher

This application deciphers signaling data on the GPRS-Gb interface.
Ciphered messages, for which the subscriber ID (IMSI) and key (Kc) are
known, are replaced by deciphered messages and thus enable a further
analysis of the signaling data.

On the GPRS-Gr interface, the Decipher application determines the IMSIs
and keys (KCs) required to decipher the signalling data on the GPRS-Gb
interface.

Decipher Application

Figure 49: Deciphering on the Gb interface
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The following configurations are possible when working with the Decipher
application:

� You can configure a joint pipeline with logical links for the GPRS-Gb
and GPRS-Gr interfaces. To do this, assign a respective suitable
protocol stack to the logical links of this pipeline.

� You can configure two pipelines. The data sources of these pipelines
are differing logical links with differing protocol stacks.

In the first pipeline, you must assign a protocol stack for the GPRS-Gb
interface to the logical links. Now, the IMSIs and keys determined by
Decipher are used via the LSA (Layer Specific Application) to
decipher the signalling data transmitted via the Gb interface. In this
pipeline, you can also use another application.

In the second pipeline, you must assign a protocol stack for the
GPRS-Gr interface to the logical links and then start the Decipher
application in this pipeline. Now, Decipher determines the IMSIs and
keys transmitted via this interface.

Figure 50: Decipher configuration with two pipelines
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Erlang Measurements

The Erlang application is a pre-defined statistics application that measures
the signaling load in the individual signaling channels.

This application analyses all protocols and protocol stacks.

GPRS MM/SM Statistics

The GPRS MM/SM Statistics application provides you with an overview
of GPRS mobility and session management procedures for the entire
GPRS network.

This application analyzes all protocol stacks that use GMM/SM as a
protocol layer.

GPRS-Gb Analyzer

The GPRS-Gb Analyzer application provides you with an overview of the
GPRS connections and requested connections, as well as their ”Quality of
Service Parameters” (QoS).

The data can be analyzed statistically during the current measurement.
Filters can be set to exclude data of minor interest. The results of the
GPRS-Gb Analyzer can be saved in a statistics file for later evaluation.

NOTE. For detailed information on how to run the GPRS-Gb Analyzer
refer to the chapter GPRS Monitoring and to the Online Help.
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IP Traffic Analyzer

The IP Traffic Analyzer maintains two views of communication in real
time:

� IP View organizes the traffic by IP connection (i.e. between 
computers).

� Protocol View shows traffic organized by protocol layer (i.e. TCP,
UDP, SCTP, M3UA, etc.), and then shows the IP addresses of the
computers involved.

Therefore, the tool supports configurations for GPRS and GPRS_IP with
GB_IP (NS_IP) and Gn with GTP; IPS7 (MAP_IP over SCTP) as well as
VoIP systems running MGCP and SIP.

Host names are resolved from IP addresses by file hosts.txt. This file is not
required, but if available, a text host name will be displayed instead of an
IP address.
Sample of a hosts.txt file:

128.181.52.216 plccontrol1
128.181.117.254 amcemulator
128.181.141.162 w-meetab01
128.181.238.28 dhcp238-28
128.181.21.36 t-train06
128.181.39.71 jamaica13
128.181.239.6 dhcp239-6
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Figure 51: IP Traffic Analyzer - [IP View]
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Nortel Frame Number

The Nortel Frame Number application can only be used for GPRS
Nortel-type protocols.

It calculates the frame number (FN) implicitly contained in the data flow
from the following parameters in the data flow:

� Multi frame number (MFN)

� Block number (BN)

� Number of idle bursts (Nib)

The calculated frame number (FN), status and error messages are fed into
the pipeline as text messages and can be evaluated in the monitor.

PCR (Preventive Cyclic Retransmission)

The PCR application enables you to filter out repeated MSUs from an
offline pipeline by means of the PCR procedure (preventive cyclic
retransmission). You may want to remove these messages in order to
obtain a smaller amount of data consisting of relevant data.

The use of this application only makes sense for offline pipelines if the
recording file contains non-suppressed PCR MSUs. In online pipelines, the
logical link can remove the PCR MSUs.

The application can be applied for all MTP-based protocols.
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Service Profile Statistics

The Service Profile Statistics application provides you with an overview of
the IP-based TCP and UDP protocols’ service profiles.

The availability of the specific protocol layer in the protocol stack used is
a condition for the use of the Service Profile Statistics application: The
TCP or UDP protocol must, as a rule, be in the protocol stack. If this is not
the case, you will be informed accordingly.

NOTE. Only when the above-stated protocol layers are in the stacks of the
configured links the Service Profile Statistics application can be started.
Otherwise, configure the data source again (Source or Recording File), by
assigning different stacks.



Basic Operations

68 K1297-G20 Monitor V 3.00 Short Introduction

Statistics

In the Statistics setup you can define your own counters based on specific
protocols, logical links, errors, and/or frame lengths. The RealChart
program allows you to change the display settings of each diagram. Data
can be viewed as tabular, line, bar, or pie charts.

Open the Application  Window in the pipeline with LMC, and select
Statistics.

The Statistics window will open. Here you may define counters (RMC) for
the desired events, messages, and so forth. They will be calculated and
displayed as defined in the RealChart setup. Files can be saved in several
formats.

The Statistics application allows you to evaluate and graphically display
received signaling data or data from a recording file in real time. For each
message that you want to evaluate, you can define a counter that counts
messages of this type as they are received. You can also set counter limits
(upper and lower limits) that cause a specific trigger action. The
K1297-G20 Monitor reads and displays the value of each defined counter
on the screen at adjustable time intervals. The counter is then reset, and
the next interval starts.

A separate program, RealChart, displays the current counter states and
also allows you to view measurement data in tables or graphical diagrams
in real time. You can combine several counters in one table or diagram.
All counters in a diagram belong to a group, of which several can be
defined.

Figure 52: One of several output formats of the Statistics application
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Traffic Channel Analysis

The Traffic Channel Analysis (TCA) application analyzes a signaling
channel. The traffic channel (basic channel) assignment controlled by this
signaling channel is evaluated. The application supports all ISUP, TUP, BT
NUP protocols.

For configuring the Traffic Channel Analysis application proceed as
follows:

1. Click the applications element in the pipeline.

2. Select TCA in the Select Application Program dialog box.

Two lists in the TCA dialog box display the protocol stacks assigned to
the data source/recording file and the available protocols in these
stacks.

3. Select the desired protocol stack in Available stacks.

The Available protocols list now displays the protocols (from this
stack) that may be monitored.

4. Select the desired protocol.

5. In the Refresh rate field, specify a time period in which the measured
values are to be displayed.

The RealChart tool displays the results of the Traffic Channel Analysis
application in tables and diagrams. The table provides two display formats
for the recorded data:

� Currently used Channels: Provides an overview of the number of
currently used traffic channels per PCM. The monitored PCM links in
this overview are organized in groups of 16.

� Max. used Channels: Provides an overview, displayed in lines and
sorted according to time periods, of the maximum number of used
traffic channels for each PCM link. The values are displayed in a
separate column.



Basic Operations

70 K1297-G20 Monitor V 3.00 Short Introduction

To switch to the display of bar charts, select Diagrams → Max. used
Channels → Bar in the context menu, and choose the desired group of
time slots.

Figure 53: TCA output of Max. used channels
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Tools
Traffic Analyzer

The Traffic Analyzer tool provides traffic information about each
connected line. It analyzes the traffic by channel scanners based on each
measurement board.

To run the Traffic Analyzer tool, select Traffic Analyzer from the Tools
menu in the K1297-G20 Monitor main window. For more detailed
information refer to the Online Help.

Load-Meter

While running measurements, you can use the Load-Meter program which
provides capacity usage information on individual K1297 interfaces and
the PC card.

In case of an overload situation (too much traffic on a link) the display
will contain red bars.

Figure 54: Load-Meter

NOTE. If several interface cards are installed on the K1297, it is best to use
all cards except for the first one to receive data. The system uses the
memory area of the first card to manage the specified configuration. This
configuration allows the optimum load distribution even when running the
links at a high load.
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PCM Check

The PCM Check automatically detects and displays the type of signalling
received on connected E1/DS1 links. Connected traffic to whether
signalling in SS#7, LAPD /LAPV, Abis or TRAU is running on E1/T1 is
detected automatically. This check is located in the menu Tools →
PCMCheck.

Figure 55: PCM Check

The PCM Check is useful only if the K1297-G20 Monitor is receiving real
data over the interfaces. It can be used to provide a quick overview of the
channel assignments within a PCM frame. An explanation of the symbols
can be found in the K1297-G20 Monitor Help application.
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Real Chart

The RealChart tool works only together with one of K1297 Monitor
statistics applications (Abis Mon, BHCA, CallMon, CountAll, Erlang,
GPRS MM/SM, Service Profile Statistics, Statistics, TCA, or UMTS IuX
Statistics).

The tool evaluates tabular data in real time and displays it on-screen in
various chart formats. Using RealChart, you can visually analyze and
create presentations using measurement data.

The system transfers data for statistical analysis to RealChart, which then
displays it either numerically (in tables) or in line, bar, or pie charts.

Figure 56: Real Chart diagram types

It is possible to run more than one statistical analysis simultaneously that
transfer signaling data to RealChart. The results for each measurement
scenario (pipeline branch) are displayed in a separate window of the
RealChart program.
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To run the RealChart tool, select RealChart from the Tools menu in the
K1297 Monitor main window. The RealChart window opens.

Figure 57: RealChart window

To define the display of RealChart diagrams, select Properties from the
Diagrams menu. The Edit Diagram dialog box opens (refer to the Online
Help for further details).
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RealChart offers a number of additional display options for evaluations
using the statistics application. The data values of each counter group
defined in the statistics application are displayed in individual diagrams.

The Diagrams menu in the Real Chart window allows you to switch
between groups and to define an individual display and diagram type for
each group. Select the desired counter group in the Diagrams menu and
the desired display in this group’s submenu:

� Number of Events: Shows the number of messages.

� Volume of Events: Shows the number of transmitted bytes.

Select a diagram type and modify the display of a diagram type via
Properties....

To print the current view, select Print –> Table or Print –> Diagram from
the File menu in the Real Chart window.

To save statistical analyses, select Save As... from the File menu. The
standard directory for RealChart files is \k1297\rcdata. Analysis files have
the extension *.rcd

To export data in a foreign file format, choose the format in the Save as
type list:

� *.csv Text file format

� *.xls Excel file format

� *.mdb Access file format

� *.dbf Dbase file format

When you reload a saved evaluation file, it appears in a new window.
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DS1/E1 Default Start Mode

Using the DS1/E1 Default Start Mode tool, you can make presettings for
the DS1/E1 (Primo) measuring board which will then be set as default
values in the Ports Setup configuration dialog box.

The presettings become valid the next time you start the main program. If
you load an already existing configuration file, that has settings deviating
from the default settings here, the default settings will be overwritten by
the configuration file’s settings.
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Key Manager

With the Key Manager tool you can administer license keys for the K1297
Monitor. You can view the installed keys, add newly licensed ones and
remove expired, duplicate, or invalid keys.

NOTE. Before using the Key Manager, please ensure that the system date
has been correctly set. You can open the system calendar by double-click-
ing the clock in the taskbar.

Make safety copies (for example on disk) of the licensed key files before
using the Key Manager.

To call up the Key Manager tool, select the Key Manager entry from the
Tools menu.

The Key Manager is started. When called up by the Tools menu, the key
file used by the K1297 Monitor software is automatically opened.

Figure 58: Key Manager dialog box
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Each key is displayed in a separate line. Keys subject to a time limit,
expired keys and invalid keys are displayed at the beginning of the list.

The title bar displays the number of expired, duplicate, or invalid keys.

Modified key files which have not yet been saved are displayed with the
character * in the title bar. The individual columns have the following
meaning:

� State displays the state of the individual keys. Refer to the Online Help
for details.

� Device displays the device number (PC version: dongle number), for
which the key is valid.

� Name displays the ordering number of the paket for which the key is
valid.

� MLFB and Version display detail information about the paket.

� Created displays the creation date of the key. For time-limited pakets,
the first valid date is displayed.

� Expired displays the last valid date for a time-limited key. For keys
with unlimited validity, unlimited is displayed.
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NTP Configuration

To monitor links on distant sites of a communications network it is
necessary to carry out the measurement concurrently with two or more
protocol testers. In order to evaluate and merge measurement data of
several protocol testers, it is crucial to synchronize the system time of all
involved protocol testers to a reference time source.

If the protocol tester is connected to a TCP/IP-based network, you may
operate the NTP Configuration tool.

The NTP Configuration tool synchronizes the clock of K1297 Protocol
Testers to an NTP reference clock. Using the NTP Configuration tool, it is
possible to synchronize several protocol testers via the Internet and
achieve an accuracy of down to 10 ms.

You can use the NTP Configuration tool to continuously correct the clock
of a protocol tester.
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GPRS Monitoring

K1297-G20 Monitor V 3.00 supports the monitoring of the GPRS-inter-
faces Gb, Gi, Gn, Gp, Gs as well as the MAP-based interfaces Gc, Gd, Gf
and Gr. 
Additionally, manufacturer specific GPRS Abis-interfaces are supported.

As the specifications for GPRS are still subject to changes, different
versions of protocols will be delivered. All GPRS related protocol stacks
can be found in the directories c:\K1297\stacks\gprs and
C:\K1297\stacks\ip_gprs

The nomenclature follows the following rule:

gprs_<interface>_<smg#>.stk

Thus, gprs_gb_29.stk is the protocol stack for the Gb-interface according
to SMG#29.

For the Abis-interfaces the following rule applies:

Abis_<manufacturer>_<smg#>_<u/d>.stk

So, abis_xyz_smg29_u.stk  should be used for monitoring the Abis-inter-
face of company XYZ in Uplink.

Logical Link Configuration for the Gb-Interface

The protocol stack for the Gb-interface is based on Frame Relay (FR) on a
PCM30/PCM24 line. Frame Relay supports three different modes offering
a bit rate of 8 kBit/s to 1984 kBit/s.
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Channelized Mode. Each Frame Relay Bearer channel has a bit rate of 64
kBit/s.

Unchannelized Mode. The complete PCM line forms a Frame Relay Bearer
channel offering a bit rate of 1984 bit/s for E1 lines (31 times 64 kBit/s,
timeslot 0 is used for synchronization) and 1536 kBit/s for DS1 lines.
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Fractional Mode. Using the fractional mode, any bit combination may be
used to build a Frame Relay Bearer channel.

The K1297-G20 Monitor does support all of these three Frame Relay
modes. In order to be able to monitor an Unchannelized or Fractional
Frame Relay connection, each card / interface has to be configured for the
so called Special Mode.

1. Therefore select menu item DS1/E1 Default Start Mode from the Tools
menu.
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The following dialog box appears:

2. Select the Special Mode, press the OK button, quit the K1297-G20
Monitor application, and start it again.

The interfaces will now work in the special mode and you will be able
to select the Fractional Mode as level 2 method in the Logical Link
Configuration dialog box. To change the cards back to the Standard
Mode, simply change the setting in the dialog box and restart the
K1297-G20 Monitor application.
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Restrictions

� While the Standard Mode supports the configuration of up to 64
unidirectional (32 bi-directional) logical links with a bit rate of 64
kBit/s each, the Special Mode supports up to 16 unidirectional 
(8 bi-directional) logical links.

� Each bi-directional unchannelized Frame Relay connection takes away
four unidirectional links, thus a total of four unchannelized Frame
Relay connections can be set up for one DS1/E1 Monitoring board.

Channelized, fractional, and unchannelized Frame Relay connections
could be mixed on one DS1/E1 Monitoring board, taking into account
the maximum number of logical links in Special Mode.
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GPRS Applications
K1297-G20 Monitor V 3.00 includes the following new features for GPRS
measurements:

� Call Trace on different GPRS interfaces

� GPRS Gb Analyzer

� GPRS MM/SM Statistics

Realtime Single GPRS Calltraces

GPRS calltraces are now possible on the follwing interfaces:

� Gb interface

� Gn / Gp interface

� Gr / Gc interface

Available parameters for selection are IMSI, Mobile Subscriber ISDN No.,
MSRN, IMEI, TMSI, IP Address, and Cause Value.

For further details, see section Applications / Calltrace and Calltrace
Sequencer.
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GPRS-Gb Analyzer

The GPRS-Gb Analyzer application provides you with an overview of the
GPRS connections and requested connections, as well as their ”Quality of
Service Parameters” (QoS).

The data can be analyzed statistically during the current measurement.
Filters can be set to exclude data of minor interest. The results of the
GPRS-Gb Analyzer can be saved in a statistics file for later evaluation.
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Setting Up a GPRS Gb Analyzer Application. To set up the application, proceed
as follows:

1. Click the Application  processing element in the pipeline.

2. Select GPRS-Gb Analyzer in the Load / Unload Monitoring Applica-
tion Programs (Mon APP) dialog box. The GPRS-Gb Analyzer main
window opens.

Figure 59: GPRS-Gb Analyzer main window

The current GPRS-Gb Analyzer pipeline will be displayed in the upper
section of the main window. This visualizes the current configuration.
Each processing element represents a part of the application.

The application is configured, started and monitored in this window.



GPRS Monitoring

K1297-G20 Monitor V 3.00 Short Introduction 89

3. Switch off the On/Off switch in the GPRS-Gb Analyzer pipeline next to
the CDR File processing element. The Start dialog box opens.

Figure 60: Start dialog box

Select Append if you want to add the new data to the end of the file or
select Overwrite if old data can be overwritten.

4. Switch on the On/Off switch next to the CDR File processing element.
The contents of the CDR file are displayed in the GPRS-Gb Analyzer
main window.

Figure 61: Loaded GPRS Gb Analyzer
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5. To define filter options, click the Filter processing element in the
GPRS-Gb Analyzer pipeline. The Filter settings dialog box opens.

Figure 62: GPRS-Gb Analyzer, Filter settings dialog box

Activate the Filter On check box and configure your desired filter
options. For further details, refer to the Online Help.
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Evaluating a GPRS Gb Analyzer Application. The results from the GPRS-Gb
Analyzer application are displayed in the GPRS-Gb Analyzer main
window (see figure 61).

Each line represents the connection state for each data record or a call
detail record (CDR). You can also view details of a data record from the
event list. Therefore, double-click on one of the data records in the main
window. The GPRS Gb Mon Detail View dialog box opens.

Figure 63: GPRS-Gb Analyzer, Detail view

You can also evaluate data records in the Analysis window of the
GPRS-Gb Analyzer or record them in a statistics file as described below.
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Evaluating the Results in the Analysis Window. Analysis is only selectable if
you have installed the GPRS-Gb Analysis packet. Call up the Analysis
window by clicking the Analysis element in the GPRS-Gb Analyzer
pipeline.

Figure 64: GPRS-Gb Analyzer, Analysis window

This window enables access to the following evaluations: Timing,
Troubleshooting, Quality of Service and Service statistics. Select one of
these statistics by clicking the corresponding button on the left toolbar of
the Analysis pane.

You can also analyze failure causes in detail. To do this, click on the
Cause list button next to the corresponding list entry. The Cause List
dialog box opens displaying the detailed list of failure causes.

For further evaluation, select one or more specific causes from the list.
Activate the appropriate check box of the desired entries. The Matched
Causes dialog box opens. A list of assigned data records and their
parameters will be displayed for each selected failure cause.
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Evaluating the Results by Writing them in a Statistics File. The statistics created
by the Analysis can be written in a statistics file. If you have configured a
filter, only the data that were able to pass this filter will be stored in the
file.

Supported output formats are *.txt and *.xml. You can open a statistics file
from an external program that supports the formats *.txt or *.xml. For
further information, refer to the appropriate topics in the Online Help.

To write the analysis in a statistics file, click the Options button of the
Statistics-File processing element. The Statistics File Option dialog box
opens.

Figure 65: GPRS-Gb Analyzer, Statistics File Option dialog box

Define your desired statistics files in this dialog box. For further
information, refer to the Online Help.
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GPRS MM/SM Statistics

The GPRS MM/SM Statistics application provides you with an overview
of GPRS mobility and session management procedures for the entire
GPRS network.

This application analyzes all protocol stacks that use GMM/SM as a
protocol layer.

Setting Up a GPRS MM/SM Application. To set up the application, proceed as
follows:

1. Click the Application  processing element in the pipeline.

2. Select GPRS MM/SM Statistics. in the Load / Unload Monitoring
Application Programs (Mon APP) dialog box. The GPRS MM/SM
Statistics dialog box opens.

Figure 66: GPRS MM/SM Statistics dialog box
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3. Determine the statistics that are to be displayed in the Statistics Output
group box.

� Attach Overview states the relation between the requested
connection setups (Attach Req.) and those that are accepted (Attach
Accept) or rejected (Attach Rej.). For this purpose, the MTRQ
(Attach Request), ATAC (Attach Accept) and ATRJ (Attach Reject)
messages are evaluated.

� Routing Area Update Overview shows the temporal course of
routing messages. These messages show all changes in the routing
area of an MS (Mobile Station) within a GPRS network. For this
purpose, the RARQ (Routing Area Update Request), RAAC
(Routing Area Update Accept) and RARJ (Routing Area Update
Reject) messages are evaluated.

� PDP Context Overview shows the temporal course of the PDP
context connections. For this purpose, the APCR/RPCA (Activate
PDP Context Request/Request PDP Context Activation), APAC
(Activate PDP Context Accept), APRJ/RPCR (Activate PDP
Context Reject/Request PDP Context Activation Reject) and
MPCA/MPCR (Modify PDP Context Accept/Modify PDP Context
Request) messages are evaluated.

4. Determine a time period in which the measured values are to be read
out in the Refresh rate field.

5. Select one of the options under Send output to. Real Chart transfers the
results of the Erlang application to the RealChart tool. File saves the
results in a *.csv (Comma Separated Value) file.

6. If you want to save the data in a file, determine whether they are to be
written in a new file or in an existing one under Filemode.

To select location or file, click the File button. The d:\k1297\log
directory opens. You can create a new *.csv file or select an existing
one.

7. Confirm with Start.
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Evaluating a GPRS MM/SM Application. You can follow the evaluation of the
results in real time in the RealChart tool. After starting the application,
RealChart starts up, displaying the measured values in a table. Per interval,
one new table line with the current values is output.

Figure 67: Evaluating a GPRS MM/SM application

The window gives you an overview of the individual protocols and
messages. Three different representations are available:

� The Attach Overview displays the relation between the requested,
accepted and rejected connection setups.

� The Routing Area Update Overview shows the temporal course of
routing messages.

� The PDP Context Overview shows the temporal course of the PDP
context connections.

You can choose between displaying the Number of Events or the data
volume of data transmitted thereby in bytes (Volume of Events).
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Appendix A: User Interface

This appendix describes some features of the K1297-G20 user interface,
such as tool bars, menu bars, short cuts and buttons.

Common Toolbar

You can open and switch windows using the following buttons in the
common toolbar:

Table A–1: Command Buttons 

Button Meaning Button Meaning

Monitor Window(s) Data Flow Window (main
screen)

Create a new MTP- based
protocol stack

Create a new LAPx-based
protocol stack

Open the protocol stack
editor.

Change between different
protocol stack editors

Switch between different
monitor windows

Status Window

Arrange Icons Cascade Windows

Tile Windows (vertical) Tile Windows (horizontal)

Monitor Setup Change Column 
Configuration

Show / Hide Pipeline Bar Maximize Frame View

Minimize Short View Minimize Frame View

Minimize Packet View Go to first available frame

Go to last available frame Start Measurement
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Table A–1: Command Buttons (Cont.)

Button MeaningButtonMeaning

Stop Measurement Pause Measurement

Display in Live Mode Display in Ring Mode

Activate display zoom Undo display zoom

Display incoming frames
in real-time, scroll auto-
matically

Supress display of incom-
ing frames, scroll manu-
ally

Add Online Monitoring
Pipeline

Add Online Recording
Pipeline

Add Online Statistics
Pipeline

Add Offline Monitoring
Pipeline

Add Offline Recording
Pipeline

Add Offline Statistics
Pipeline

Table A–2: Protocol Stack Editor 

Icon Meaning

Call Add Protocol dialog box

Delete Protocol from the selected protocol stack

Call Protocol Setup dialog box
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Menu Bar
This section describes functions available from the menu bar. For more
information about these menus, see the Online Help.

The K1297-G20 Monitor software includes the following main menus
accessible in all program situations:

Table A–3: Standard Main Menu  

Menu Function

File Access to file functions (open, save, close, print). Access to already
opened files.

View Define display of toolbars.

Tools Start the autoconfiguration. Access to supplementary programs (tools). 

Options Access to toolbars and window options of the K1297-G20 Monitor
software.

Window Access to currently open main windows. Commands for arranging
windows on the screen.

Help Access to K1297-G20 Monitor Online Help.

In addition, there are main menus for the program modules of the
K1297-G20 Monitor software. These main menus are only displayed if the
corresponding main window is in the foreground.

Table A–4: Additional Menus of the Program Modules  

Window Menu Function

Data Flow Scenarios Configuration of online and offline
scenarios. Adding / removing pipelines.

Protocol Stack Editor Protocol Stack Configuring protocol stacks. Editing
protocol parameters.
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Table A–4: Additional Menus of the Program Modules  (Cont.)

Window FunctionMenu

Monitor Monitor Searching through messages. Restricting
display. Setting data representation.

Pipeline Elements Access to the processing elements of the
actual pipeline.

Edit Searching through messages and text
messages; Copying data into the
clipboard; Copying configuration of
monitor window.

Context Menus

In many program situations, context menus feature the commands directly
associated with an item on the screen. These context menus only appear
temporarily and are closed once you have selected a command.

There are two ways of opening context menus:

� Select the relevant screen item (such as a processing element in a
pipeline) and click the right mouse button.

� Select the relevant screen item and press < UP ARROW >  + < F10 >.
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Shortcut Keys and Buttons
Keyboard Layout

The K1297 keyboard was designed specifically for use with a measuring
device and features special function keys. The function keys and key
combinations are also listed in the individual Help topics.

Furthermore, you can operate the K1297 entirely via keyboard. For
operators who are used to working with the mouse, the following list
provides an overview of software operation if no mouse is available.

All menus, dialogs, options, lists or commands feature an underlined letter
(access key). Pressing < ALT > + < ACCESS KEY > activates the desired
menu, field, or function.

Table A–5: Programs and Windows 

Action Press

Switch between programs < ALT > + < TAB >

Switch between main windows < CTRL > + < F6 >

Switch between tabs in a main window < CTRL > + < PAGE UP > or < CTRL > + 
< PAGE DOWN >

Switch between panes on a tab < CTRL > + < TAB >

Open main menu < ALT > + < ACCESS KEY >

Close program < ALT > + < F4 >

Table A–6: Menus 

Action Press

Select menu < ALT > + < ACCESS KEY >, 
for example, < ALT > + < W > for Window
menu

Open menu < UP ARROW > or < DOWN ARROW > +
< RETURN >
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Table A–6: Menus (Cont.)

Action Press

Close menu < ESC >

Open context menu < UP ARROW > + < F10 >

Close context menu < ESC >

Open system menu of main program < ALT > + < SPACEBAR >

Table A–7: Processing Elements 

Action Press

Open the dialog of a selected process-
ing element

< SPACEBAR >

Table A–8: Directory Trees 

Action Press

Open a directory tree level < RIGHT ARROW > or < + >

Close a directory tree level < LEFT ARROW > or < – >

Move cursor up / down in a directory
tree

< UP ARROW > / < DOWN ARROW >

Table A–9: Dialogs 

Action Press

Select element, for example a text
field

< ALT > + < ACCESS KEY >

Select next / previous field in the
dialog

< TAB > / < UP ARROW > + < TAB >
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Table A–9: Dialogs (Cont.)

Action Press

Activate / deactivate check box option < SPACEBAR >

Reverse selection of a dialog field < ESC >

Select next element within group
boxes

< DOWN ARROW >

Select previous element within group
boxes

< UP ARROW>

Table A–10: Lists 

Action Press

Select entry in list boxes... < SPACEBAR > after selecting entry using 
< UP ARROW > or < DOWN ARROW >

... and accept them for the input line of
the list

< RETURN >

Select consecutive entries in a list < UP ARROW > + < DOWN ARROW > or <
UP ARROW > + < UP ARROW >

Select non-consecutive entries in a list < CTRL > while selecting entry using 
< UP ARROW > or < DOWN ARROW > and
confirm with < SPACEBAR >

Table A–11: List Boxes 

Action Press

Open < DOWN ARROW >

Close < ALT ] + < UP ARROW ]

Select entry < DOWN ARROW ] and < RETURN ] to
select entry
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